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Visual Studio
NET Framework
Visual C# ArayUzU ile Program Yazma, Derleme ve Kosturma

Sikca Sorulan Sorular

Visual Studio

Birinci Boliimde, kaynak programi, derlemeyi, gerektiginde programi diizeltmeyi (debug) ve derlenen programi
kosturmay1 (run) 6grendik. Bu isleri yaparken basit bir editor ile C# derleyicisine (cs.exe) gereksememiz oldu.
Programi derleme ve kosturma eylemlerini konsoldan yazdigimiz komutlarla gerceklestirdik. Hepsi ¢ok yalin ve
kolay islerdi. O yaptiklarimiz hemen her dildeki program i¢in yapilanlardir ve igin 6ziidiir. Programciliga baglayan
herkes o siireci bilmek zorundadir.

Ote yandan, o yalin eylemler, gerekseme duydugumuz tekerlegi kendi ellerimizle yapmak gibidir. Her zaman
miimkiindiir; ama en iyi yol degildir. Birileri bizim i¢in tekerlegi yapmislarsa, onu hazir alip arabamizi yiirtitmek
daha akillica olabilir.

Glinlimiizde programlama isi biraz tekerlek yapmaya benzedi. Milkemmel hazir tekerleri alip kullaniyormusgasina
kaynak programi yazmayi, derlemeyi ve kosturmayi ¢ok ¢ok kolaylastiran araglart alip kullanabiliriz. Bu tiir
araglara biitiinlesik (integrated) program, kullanict dostu program, arayiiz gibi adlar verilir. Hemen her dilde bu tiir
araclar bolca tretilmistir ve programcinin emrindedir.

C# i¢in de programlamanin evrelerini kolaylastiran araglar vardir. Biz, bu derste Microsoft'un gelistirdigi Visual
Studio 2008 bitlinlesik programini (araytiz) kullanacagiz. Bunun iki strimi vardir. Birisi profesyonel
programcilar icin lisansli olan siiriimiidiir. Otekisi, programlamaya yeni baslayanlarin biitiin gereksemelerini
karsilayacak nitelikteki serbest siiriimiidiir. Ucretsizdir, lisans almaya gerek yoktur ve internetten
indirilebilmektedir.

Visual Studio 2008, Microsoftun C++, C#, VB, J# , Jscript dillerinde program yazmay: ve derlemeyi
kolaylastirmak i¢in hazirladig1 ¢ok amagh bir arayiizdiir.



.NET Framework

Programlamaya yeni baslayanlar1 gereksiz ayrintiyla bogmamak i¢in, Visual Studio'nun i¢ yapisini
aciklamaya girmeyecegiz. Onu bir otomobil gibi gérelim, motorunun kaputunu hi¢ agmadan direksiyonuna
oturalim ve kumanda tablosundaki diigmelerin islevlerini 6grenelim. Ciinkii biz baslangicta motor
yapimcisi degil, araba siirtictisii olmak istiyoruz. Siiriicti belgesi bize uzun zaman yetecektir. Epeyce zaman
sonra zaten merak ederek motorun kaputunu ag¢ip, onun i¢indekileri gérmek isteyecegiz. Ancak, su kadarini
soylemek hem yararli hem gereklidir. Microsoft C++, C# VB, J# gibi dilleri derlemek ve calistirmak i¢in
.NET Framework denilen ortak bir platform yaratti. C# kaynak programlari kendiliginden o ortama tasinir,
orada derlenirler, orada ¢alisirlar. O nedenle, C# dilini 6grenirken, ayr bir ¢aba harcamadan ve ¢ogunlukla
farkinda bile olmadan . NET Framework yapisini da epeyce 6grenmis olacagiz.

.Net Framework genel amagh bir program gelistirme platformudur. 2000 yilinda Microsoft firmasi
tarafindan ilk siiriimil ortaya konmustur. Bu kitap yazilirken, 3.5 stirimii piyasaya ¢ikmig durumdadir.
Zamanla yeni siiriimlerinin ¢ikmasi dogaldir. Islevleri bakimindan java platformu ile aymdir. Her ikisiyle
istemcide, sunucuda, mobil ya da gomiilii cihazlarda uygulama programlar1 gelistirilebilir, web
uygulamalari, veritabani uygulamalari gibi bir ¢ok is yapilabilir. Her ikisi de isletim sistemine ve donanima
baglilig1 ortadan kaldirmay1 hedeflemektedir.

Bunu yapabilmek i¢in, java, bellekte virtual machine (VM) denilen sanal bir makina yaratir. Java derleyicisi
kaynak programi bytecode denilen ve VM lizerinde g¢alisabilen bir tiir sanal makina diline doniistiiriir.
Boylece platformdan bagimsizlik saglanir.

Microsoft'un uygulama gelistirme dilleri olan C++, C# VB, J# ile yazilan kaynak kodlar derlenince /L
(Intermediate Language) koduna donisiirler. Bu dontigiim, java'nin bytecode'una benzetilebilir. Sonra JIT
(Just-in-Time) derleyicisi kosturulacak /L kodunu makine diline doniistirtr. /L bazi kaynaklarda MSIL
(Microsoft Intermediate Language) veya CIL (Common Intermediate Language) diye adlandiril. CLR
(Common Language Runtime) ise IL koduna doniisen programlarin kostugu yerdir.

.NET Uygulamalari

Common Language Runtime (CLR)

Windows Isletim Sistemi

Bagka bir deyisle, C++, C# VB, J# dillerinden biriyle yazilan bir program derlenince dogrudan Windows
Isletim Sistemi tizerinde ¢alismaz; onun iizerinde kurulan sanal CLR iizerinde ¢alisir. Ciinkii C++, C# VB,
J# dillerinde yazilan programlar derlenince, Windows Isletim sisteminde galisabilen (executable) kodlara
degil, /L diline doniistir. Bunun ne anlama geldigini, basite indirerek, soyle aciklayabiliriz. C# dilinde int
tipi bir degisken tanimladigimizda, derleyici onu .NET Frameworkta'ki karsihigi olan Int32 tipine
dontigtiirtir. Bunun gibi, kaynak programi hangi dilde yazarsaniz yaziniz, oradaki her sey .NET
Framework'taki karsihigina doniisiir. Genellestirirsek soyle diyebiliriz. C++, C# VB, J# dillerinin veri
tipleri .NET'in CTS (Common Type System) denilen veri tiplerine doniisiir. Béylece bu diller i¢in ortak bir
platform yaratilmig olmaktadir. C# dilinin veri tiplerinin .NET 'deki karsihiklari Veri Tipleri ve
Degiskenler boliimiinde ayrintili olarak ele alacagiz.

.NET Framework ¢ok genis bir kiitiiphaneye sahiptir. Onunla iligkili olarak CL/ (Common Language
Infrastructure), CTS (Common Type System), metadata, VES ( Virtual Execution Environment), CLS
(Common Language Specification) gibi kavramlar1 duyabilirsiniz. Ama onlar1 simdilik gozardi
edebilirsiniz. Ciinkii biz, Visual Studio ve .NET 'in i¢ yapistyla degil, kumanda odasiyla ilgili olacagiz.
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Kaynak Program — IL Kodu -

Derleme Kosturma
(Compile Time) (Run Time)

Bu kisa agiklamadan sonra, Visual Studio ile ¢alismaya baslayabiliriz. Bilgisayarinizda Visual Studio 2008
'in iginde ayr1 bir modiil olan Microsoft Visual C# 2008 Express Edition 'in yukli ve c¢alisir durumda
oldugunu varsayiyoruz. Nasil yiiklenecegini internetten indirdiginiz yerden okuyabilirsiniz.

Visual C# Arayiiziinii Baglatmak

Baslat -> Programlar -> Microsoft Visual C# 2008 Express Edition sekmesini tiklaym. Karsmiza suna
benzer bir pencere gelecektir.
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Sol iistteki Recent Projects bolumi sizde farkli olacaktir.

Visual Studio ilk agilisinda projeleri kaydedecegi dizini sorar. O anda istediginiz siiriiciide istediginiz bir
dizin yaratabilir veya Visual Studio'nun 6nerdigi ondeger (default) proje dizinini kabul edebilirsiniz. Bu
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kitabmn yazildig1 makinada c:\vsProject adli bir dizin yaratilmistir. Biitiin projeler oraya kaydedilmektedir.

Ust satirda menii, onun altinda araclarin yer aldig1 satir yer alir. Onun altindaki satirin solunda Start Page,
saginda Solution Explorer sekmelerini géreceksiniz. Start Page sekmesine sag tiklaymiz ve agilan pencerede
Close 'u tiklaymiz. Goriintiideki pencere kapanacaktir. Sonra File -> New Project 'i tiklaymiz. Goriintiiye
New Project penceresi gelir:
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Bu pencerede bize alti segenek sunuluyor. ilk islerimiz konsol uygulamalari olacaktir. C# ile nesne
programlamay1 onunla 6grenecegiz. Ondan sonra Steki uygulamalari kolayca yapabilir duruma gelecegiz.
Pencereden Console Application 'i tikliyoruz. Onun ikonu secili duruma gelir. Sonra, pencerenin altindaki
Name alanina gidiyoruz. Bu alan, yapacagimiz konsol uygulamasinin hangi aduzayina (namespace) ait
oldugunu belirliyor. Name alaninda ConsoleApplicationl adi1 yazilidir. Oldugu gibi birakabiliriz ya da

istedigimiz bagka bir ad verebiliriz. Baslangi¢ diyelim ve OK diigmesine basalim. Kargimiza su pencere
cikar:
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Sol tstte Baslangi¢. Program sekmesi altinda Visual Studio 'nun editér pencesi goriiniiyor. Bu pencerede,
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kaynak program i¢in Visual Studio bazi temel kodlar1 hazir yazilmis olarak 6niimiize koyuyor.

using System;

using System.Collections.Generic;
using System.Ling;

using System.Text;

namespace Baslangig

{

class Program

{

static void Main(string[] args)
{
}

Bu programin ilk dort satirmin her birisindeki using sozciigii bir namespace (aduzay) ¢agiriyor. Ilke olarak,
cagrilan bir ad uzaymdaki smiflar, o simiflarin i¢indeki degiskenler ve metotlar sanki bu programin i¢inde
tanimlanmis gibi kullanilabilir (kisitlar1 ayrica gorecegiz). Istedigimiz zaman, using anahtar sozciigii ile
baska aduzaylari da gagirabiliriz. ilk derslerde, yalnizca System aduzayina gereksememiz olacak. O
nedenle, sonraki ti¢ satir1 silebiliriz. Silmesek de bize bir zarar vermezler.

Visual Studio, bize yaptig1 program onerisinde aduzayinin (namespace) adinin 'Baglangi¢’ oldugunu
belirtiyor. Zaten bu adi biz vermistik. Simdi yazacagimiz programdaki smif veya siflar, Baslangi¢
aduzayma ait olacaklardir. Bu aidiyet, fiziksel kayit ortaminda degil, mantiksal (logic) olarak yapilir.
Dolayisiyla, biz programlarimizi istedigimiz dizin veya alt dizine kaydedebiliriz.

Hemen belirtelim ki, yazdigimiz her program i¢in bir namespace (aduzayi) belirlemek zorunda degiliz.
Programa namespace blokunu koymadigimiz zaman, yarattigimiz smiflar hi¢ bir aduzaymna ait olmazlar;
ama kendi baslarma c¢alisabilirler; bagka aduzaylarini ¢agirabilirler.

Programin sonraki satirlarina bakarsak sunu goriiyoruz. Visual Studio, bize sinif (class) adi olarak Program
Oneriyor ve hemen o sinifin i¢inde Main () metodunun imzasi atiyor. Sinif adini aynen birakabilir veya
istedigimiz bir ad ile degistirebiliriz. Ornegin, Giris diyelim. IIk programimizda Visual Studio ile kaynak
programimizi yazmay1 ve derleyip kosturmayi 6grenmek istiyoruz. Onun igin, basit bir deyim yazmakla
yetinecegiz. Gelenek oldugu gibi, konsola “Merhaba C#“ yazdiralim. Bunu yazdirabilirsek, ayni
yontemle bir roman bile yazdirabilecegimizi biliyoruz. Bunu yapmak i¢in, dnceki bolimde gordiigiimiiz
gibi, Main () metodunun govdesine Console.Writeline ( “Merhaba C# “ ) deyimini
eklememiz yetecektir. Boylece, Visual Studio 'nun editor penceresinde programimiz su bigimi alir.

using System;

namespace Baslangig

{

class Giris

{
static void Main(string[] args)

{

Console.WritelLine( "Merhaba C# " ) ;
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}

Simdi programimizi derleyebiliriz. Ama ondan 6nce yazdiklarimizi kaydetmekte yarar var. Ekranin saginda
yer alan Solution Explorer — Baglangi¢ penceresindeki Program.cs Visual Studio 'nun 6nerdigi addir. Bu
ad1 koruyabiliriz veya istiyorsak degistirebiliriz.

C# programlart . cs uzantist alir ve smifin adini almak zorunda degildir. C# buna aldirmaz. Ama iginde
bir tek sinif olan programlarda snif adi ile program adin1 aynm yaparsak, ¢agrisimda bize kolaylik saglar.
Nasil yapildigim1 gérmek i¢in, Solution Explorer — Baslangi¢ penceresindeki Program.cs adma sag
tiklayalim, agilan penceredeki Rename sekmesini segerek, yeni adi girelim. Sinifin admi tagisin diye,
programin admi Giris.cs olarak degistirelim. Isterseniz bagka ad da verebilirsiniz. Sonra File -> Save
Giris.cs segenegini tiklayarak, programi kaydedelim. Ayni anda birden ¢ok programla ¢aligabiliriz. Hepsini
kaydetmek icin File -> Save All secenegini tiklariz. Ayni isi, ara¢ satirindaki

il

diigmeleriyle de yapabiliriz. Soldaki diigme, etkin olan penceredekini kaydeder. Sagdaki diigme, biitiin
programlar1 kaydeder. Artik programimizi derleyelim.

Menii satirinda Debug > Start Without Debugging sekmesine tiklayiniz. Isterseniz onun yerine Ct r1+F5

tuslarma da basabilirsiniz. Konsol agilir ve {izerinde Merhaba C# goriniir:

e 2l PO v team 3 2lemd e e
Herhabm CH

Dewmm etmek dcin hix twsa hasan

Boylece, Visual Studio ile ilk programimizi yazdik, derledik ve kosturduk. Bundan sonrakiler de bu kadar
basit olacaktir. Simdi Visual Studio 'nun bazi hiinerlerini gérelim.

En sondaki '}' parantez simgesini kaldirip programi derlemeyi deneyelim. Derleyiciden su uyart mesajini
alirz.

Error | Description File Line Column Project

1 } expected C:\vsProjects\Baslangig\Baslangig\Giris.cs " 6 Baslangig

Program yazdikg¢a, benzer mesajlari siirekli aliyor olacagimiz i¢in, bu mesajin nasil okunacagini bir kez
aciklamakta yarar olacaktir:

Error siitunu programda derleyicinin buldugu hatalarin sayisi verilir. Bizim programda 1 hata oldugu
isaret ediliyor.

Description siitununda derleyicinin gérdiigii hatanmn agiklamasi verilir. Ornegimizde '} expected'
dendigine gore, programimizda ' } ' simgesinin eksik oldugu belirtiliyor.
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File siitiinunda hatanin hangi dosyaya ait oldugu belirtilir.

Line siitununda, hatanin kaginci satirda oldugu belirtilir. Ornegimizde, hatanmn 11-inci satirda goriildiigi
belirtiliyor.

Column siitununda hatanin hangi kolonda olustugu belirtililir. Ornegimizde, hatanin 6-inc1 kolonda
olustugu isaret ediliyor. [Kullandigimiz ekranin ¢6ziinirligiine bagh olarak, bizim saydigimiz kolon
numarasi, derleyicinin saydigi kolon numarasindan farkli olabilir. Ama derleyici, hatayr gordiigii yere
kiictik kirmiz1 dalga simgesi koyar. Hatay1 orada aramaliyiz.]

Project siitinunda programm hangi aduzaymna (namespace) ait oldugu belirtilir. Ornegimizde
C:\vsProjects\Baslangi¢\Baslangi¢\Giris.cs dosyasi yazilidir. Burada yazilanlar soldan
saga dogru sunlardir:  dosyanin kaydedildigi sdrici adi (C:), dizin adi (vsProject), aduzayi
(Baslanguic), sinifadi (Baslangic) vedosyaadi (Giris.cs).

Hatanm isaret edildigi yere imleci gotiiriip '}’ simgesini yazalim. Sonra, bagka bir hata yapalim. Ornegin,
govde i¢indeki deyimin sonundaki (;) simgesini kaldiralim. Bu kez derleyicimiz hatanin 10-uncu satir, 45-
inci siitunda (;) eksikliginden kaynaklandigini belirten hata mesajimi iletecektir. Ayrica hatanmn olustugu
yere kirmizi renkli kii¢iik bir dalda simgesi koyacaktir.

Error | Description File Line Column Project
1 ; expected C:\vsProjects\Baslangig\Baslangi¢\Giris.cs 10 45 Baslangig
Blok Girintileri

Yeni bir deneme daha yapalim. Programin yazilis bicemindeki blok girintilerini yok edelim:

using System;

namespace Baslangig{
class Program {
static void Main(string[] args)

{

Console.WriteLine ("Merhaba C# ");

Bu asamada Ctr1+E+D tuslarina basiniz. Programda blok girintilerinin yeniden olustugunu goreceksiniz.
Visual Studio ile ¢alisirken, programinizda blok girintileri kendiliginden olusur; onlar1 yapmak icin
zaman ve emek harcamaniza gerek yoktur. Ancak, programda s6z dizimi hatasi varsa, hata giderilene kadar
otomatik bigemleme yapilmaz.

Simdi, Visual Studio ortamini biraz daha yakindan taniyalim. Ekranin sagindaki Solution Explorer
penceresinde Baslangig¢ aduzaymi sag tiklayalim. Agilir pencerelerden Add -> Class sekmesine tiklayalim.
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Oniimiize Add New ltem adli sablonlar penceresi gelir. Bu pencerede C# ile yapilabilecek islerle ilgili
sablonlar yer alir. Bu sablonlar i¢inden Class ikonunu segelim. Pencerenin altinda Name alaninda Class1.cs
ondegeri (default vakue) yer alir. Bu Oneriyi kabul edebiliriz. Ama yapacagimiz isi ¢agristiran bir ad
vermek daha uygun olur. Class1.cs yerine Toplama.cs yazalim. Oniimiize editor penceresi gelecektir.
Editorle asagidaki programi yazalim.

Toplama.cs

using System;
namespace Baslangic

{

class Toplama

{
static int x = 3;
static double y = 14.5;

static double Topla/()
{

short z = 5;
return x + y + z;

Blok girintileri diizgiin degilse Ctrl+E+D tuslarina basarak, bloklar diizgiinlestirebiliriz. Yazdigimiz her
programi satir satir ¢oziimlemeyi; yani her deyimin ne is yaptigimmi1 anlamayi aligkanlik edinmeliyiz.
Ogrenme siirecinde bu iyi bir aliskanlhk olacaktir. Bu programu ¢oziimlersek sunlari gérecegiz. Baslangig
aduzayina ait Toplama adl bir simif ile bu smifin i¢inde Topla() adli bir metot tanimlaniyor. Smifin x ve y
adli iki degiskeni var. Smif i¢inde tanimlanan degiskenler ile metotlara sinifin &geleri (class
members) denilir. Topla sinifinin ii¢ 6gesi var. Degiskenlere, cogunlukla, veri alani ya da kisaca alan (field)
denilir. Bu kitapta degisken, veri alan1 ve alan sozciiklerini es anlamli kullanacagiz.

static int x = 3;

bildirimi int wveri tipinden x adli bir degisken tanimlandigini, bu degiskene ilk deger olarak 3 atandigini,
degiskenin static oldugunu bildirir. static nitelemesi, daha 6nce de soyledigimiz gibi, Toplama
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siifinin bir nesnesini yaratmadan x degiskenine erigilebilecegini belirtir. static nitelemesini ileride
daha ayrintili inceleyecegiz. Degiskene erigsmek demek, istendiginde ona deger atamak, istendiginde
atanmis degeri okuyup islemlerde kullanabilme yetenegine sahip olmak demektir.

static double y = 14.5;
deyimini yukaridaki gibi ¢oziimlenebilir.

public static double Topla ()
deyimi deger kiimesi double olan Topla () metodunun bildirimidir. Bu bildirimde metodun adi, deger
kiimesi ve varsa parametreleri yazilir. Bunlar bir metodu kesinkes belirtirler. O nedenle

double Topla ()

ifadesine metodun imzasi denilir. Metotlar imzalariyla birbirlerinden ayirt edilirler. Adlari, deger kiimeleri
veya parametrelerinden enaz birisi farkli ise iki metot farkli olur. Ornegin, adlar1 ve deger kiimeleri ve
hatta iglevleri ayn1 olan iki metot parametreleri farkli oldugu i¢in birbirlerinden ayirt edilebilirler.

Metot imzasinin 6niinde

public static

nitelemelerini goriiyoruz. Bunlardan static nitelemesi once soyledigimiz isleve sahiptir. public
nitelemesi ise, metoda digaridan erigimi; yani onun bagka siniflardan ¢agrilmasina izin veren bir erigim
belirtecidir. Erigim Belirtegleri mi ileride ayrintili goérecegiz.

Son olarak Topla () metodunun gévdesine bakalim. short tipinden z adli bir degisken bildirilmis ve
ona 5 degeri atanmistir. Bu sekilde metodun govdesinde tanimlanan degiskenlere metodun yerel
(local) degiskeni ya da i¢ dediskeni denir. Metodun alacagi deger

return x + y + z;

deyimi ile belirtilmistir. Bunun anlami apagiktir, fonksiyonun degeri x, vy ,z degiskenlerinin
degerlerinin toplamidir. Metodun degeri daima return anahtar sdzctigii ile belirtilir. return ifadesinden
¢ikan deger metodun deger kiimesine ait olmahdir. Bu 6rnek igin soylersek, x+y+z toplami, metodun
deger kiimesi olan double veri tipinden olmalidir. Aksi halde derleme hatast dogar.

Artik Toplama. cs programimiz tamamdir. File -> Save Toplama.cs sekmesini tiklayarak ya da
CTRL+S tuslarina basarak dosyamizi kaydedelim. Ekranin sag yanindaki Solution Explorer
penceresindeki Baslangic¢ aduzayi altinda Toplama . cs programini gérityor olmaliyiz.

Simdi ayni1 yollart izleyerek asagidaki iki programi yazalim ve kaydedelim.

Cikarma.cs

using System;

namespace Baslangig

{

class Cikarma

{
static double x = 17;
static double y = 8.5;

public static double Cikar ()
{

return x - y;
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Ana.cs

using System;

namespace Baslangig
{ class ana
{ static void Main(string[] args)
{ double y = Toplama.Topla();
double x Cikarma.Cikar () ;

Ana.cs programini ¢éziimleyelim. Ana sinifinda
static void Main(string[] args)

bildirimi ile Main () metodu tanimlanmigtir. Main () metodu genellikle bu bigemde bildirilir. Main ()
metodunun String[] tipinden args adli bir array parametresi var. Bu parametreyi g¢ogunlukla
kullanmayacagiz. Kullanmayacagimiz zaman parametreyi yazmasak da olur. Ama yazmanin sakincasi
yoktur. Main () metodu bir programi ¢aligtiran asil metot oldugu i¢in, ona ayr1 bir 6zen gosterelim ve
yukarida gosterildigi gibi parametresini yazmayi aliskanlik edinmeye c¢alisalim. Main() 'in govdesindeki
deyimleri, sirasiyla, nceleyelim.

Toplama.Topla () ;

deyimi Toplama snifi igindeki Topla () metodunu cagiriyor. Bu eyleme metot ¢cagirma veya mesaj
iletme diyoruz. Bu mesajla, bir simiftan bagka bir sinifa ait metodu ¢agirip islevini yapmasini istiyoruz. Bu
mesajlagma eylemi, nesne programlamanin (object oriented programming) {istiin bir niteligidir.

Ikinci deyim olan
Cikarma.Cikar();

deyiminin agiklamasi da benzerdir. Simdi sag taraftaki Solution Explorer penceresinde Baslangi¢ aduzayma
ait olarak yazdigimiz Ana.cs, Cikarma.cs ve Toplama.cs programlarini gériiyoruz.
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Bunlardan herhangi birisine ¢ift tiklarsak, editor penceresine onun kaynak programi gelir. Oniimiize gelen
programda, istedigimiz degisikligi yapabiliriz.
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Program se¢me isini editor penceresinden daha kolay yapabiliriz. Bencerenin iistiindeki programlar
satirinda Ana.cs, Cikarma.cs ve Toplama.cs programlarint gorebiliriz. Onlardan birisine
tiklarsak, o program editorde agilir. Her {i¢ programi tam yazdigimiza emin olunca, File -> Save All
sekmesine tiklayip her {glinii birden kaydedelim. Hepsini birden kaydetmenin ikinci bir yolu
CTRLA+Shift+S tuslarina basmaktir. Ama en kolayi, ekranin {istten tiglincti satirinda yer alan siralanmis
disketler simgesine tiklamaktir. Tek disket simgesine tiklaninca, o anda editérde etkin olan dosya
kaydedilir. Disketler grubuna tiklayinca, biitiin dosyalar birden kaydedilir.

Programlarimizi kosturmadan once, Visual Studio'nun birka¢ aracimi daha gorelim. Ornegin, Ana.cs yi
tiklay1p agalim.

Imleci herhangi bir stirin herhangi bir yerine koyalim. Sonra {istten {igiincii satir i¢indeki 5-inci ve 6-inc1
girintileme simgelerine [girinti artirip azaltan (increase/decrease indent)] tiklayarak, girintilerin nasil azalip
cogaltildigina bakalim. Eger, Visual Studio'nun otomatik yaptigi blok girintilerinden memnun degilseniz,
bu diigmeleri kullanabilirsiniz.

Tekrar imleci herhangi bir stirin herhangi bir yerine koyalim. Sonra {istten {igiincii satir igindeki 7-inci ve 8-
inci simgelere [agiklama koy/kaldir (comment/uncomment)] tiklayarak, satirlara nasil agiklama simgesi (/)
konulduguna bakalim.

Visual Studio'nun penceresine istediginiz alt pencereleri getirebilirsiniz. Bunun i¢in View agilir
penceresinden istediginizi seciniz. Ozellikle, programin kosmasi sirasinda olusabilecek hatalar1 gérmek igin
Error List penceresini agmalisiniz.

Visual Studio'nun penceresindeki 6teki simgelerin islevlerini zamanla 6greneceksiniz. Ama ¢ok merak
edenler, He 1p sekmesinden hemen bilgi alabilirler.

Bunca sabirdan sonra, artik programlarimizi kosturmay: deneyebiliriz. Ne yapacagimizi zaten biliyoruz.
Ana.cs programina tikliyoruz. Main () metodu burada oldugu i¢in, program girisi bu smiftan olacaktir.
Her programda bir tek giris yeri olabilir. Birden ¢ok Main () programi olsa bile, onlardan yalnizca bir
tanesi giris yeri olmalidir.

Ana.cs programini ¢alistirinca, onun i¢indeki Main () metodu, sirasiyla, Toplama ve Cikarma
siniflarindaki Topla () ve Cikar () metotlarimi ¢agiracaktir. Dolayisiyla, yapacagimiz is, Ana.cs
programint derleyip kosturmaktan ibarettir. Bunun i¢in

Debug -> Start Without Debugging

sekmesine tiklamak ya da CTRLAF5 tuglarina basmak yetecektir. Bunu yapinca ekrana siyah konsolun
geldigini ve icinde Hicbir hata iletisi olmadigim gorecegiz. Ote yandan, Visual Studio ekranimin altindaki
Error List penceresinde de bir uyar1 gortilmiiyor. Bu demektir ki, programlarimiz derleme hatasi (compile
time error) vermemistir; s6z dizimleri dogrudur. Ayrica kogma hatasi (runtime error) da yoktur.
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Ama konsolda programin yaptigi toplamayr ve c¢ikarmayr goremedik. Bunun nedeni apagiktir.
Istediklerimiz yapildi, ama onlar1 konsolda goremedik, ¢iinkii konsola bir sey yazilmasini istemedik. Simdi
bu eksikligi kolayca giderebiliriz. Ana.cs programini acip, Main() 'in govdesindeki iki deyimi soyle
degistirelim:

Console.WritelLine (Toplama.Topla()) ;

Console.WriteLine (Cikarma.Cikar()) ;

Bu degisikligi yapinca Ana.cs programi su sekli alir.

Ana.cs

using System;

namespace Baslangig

{

class ana

{
static void Main(string[] args)
{
Console.WriteLine (Toplama.Topla()) ;
Console.WriteLine (Cikarma.Cikar()):;

}
Simdi bunu kosturursak, konsola

22,5
8,5

yazildigini gorecegiz.

Visual Studio Express Editions

Visual Studio Express Editions Microsoft'un Visual Studio ve SQL Server adli iiriinlerinin bir uzantist sayilir.
Ogrenciler, yeni 6grenmeye baslayanlar ve hatta programcilikla bir hobby olarak ugrasanlarin dinamik
Windows Uygulamalari yapmalarmi, Web siteleri kurmalarin1 ve veritabani uygulamalar1 yapmalarini
kolaylastiran bir arag, gorsel bir arayiizdiir. Ucretsizdir. Internetten indirilebilir.

Visual Studio Express Editions su bilesenlerden olusur.

+  Visual Basic 2008 Express Edition — Ilk baslayanlarin tercih ettigi Visual Basic dili ile program
gelistirme araci

« Visual C# 2008 Express Edition — Windows uygulamalart i¢in miikemmel bir ara¢. Tamamen
Nesne Yonelimli bir dildir.

+  Visual C++ 2008 Express Edition — C++ dilini bilenlerin tercih ettigi bir yaris atidir.

« Visual Web Developer 2008 Express Edition — Dinamik web uygulamalar1 gelistirmeye yarayan
kolay kullanilir bir arag.

« SQL Server 2008 Express and SQL Server Compact Edition — Veritabani uygulamalari i¢in
kullanimi kolay ve giiglii bir arag
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Visual Studio Express Editions yukaridaki bilesenleri .NET platformu denilen tek bir platforma tasir.

NET Framework hakkinda asagida yeterli bilgi verilecektir.

Sikg¢a Sorulan Sorular

1. C# kaynak programini yazdim, derledim ve kosturdum. Bu eylemler diger dillerde yaptiklarimdan
farklh goriinmiiyor. Oyleyse .NET Framework ne ise yariyor?

NET Framework'un mimarisi klasik Windows uygulamalarina ¢ok benzer. Bir .NET uygulamasini
derledigimizde ona ait .exe ya da .dll library dosyasi ile birlikte AssemblyInfo dosyasi olusur. Bu
dosya Win32 header, metadata, manifest ve MSIL kodlarmi igerir. Biz .exe dosyasi calistirinca
Win32 header dosyast CLR'i (Common Language Runtime) harekete gecirir, ona uygulamanin
giris noktasini gosterir. CLR o andan sonra JIT (Just-in-Time) derleyicisini atesler. JIT, CLR 'dan
gelen kodlart isletim sisteminin anladigi makina diline doniistiriir. Goraldugu gibi, biz bir
programi derleyip kostururken .NET 'in (Framework, CLR, JIT, MSIL) bilesenleri devrededir,
ancak onlar perdenin arkasindadirlar, biz gérmeden rollerini oynarlar.

2. Console sinifina ait bir nesne yaratmadigim halde, o smifin Write (), WriteLine(),
Read (), ReadLine () metotlarini nasil kullanabiliyorum?

Bu metotlar System.Console smifinin statik 6geleridir. Bir sinifa ait nesne yaratilmadan o
sinifa ait statik 6geler kullanilabilir. Bu kavram ilerideki konularda ayrintili olarak agiklanacaktir.

3. Bir programda birden ¢ok smif varsa, derleyici, Main () metodunun hangi smifta oldugunu nasil
biliyor? Birden ¢ok sinifta Main () metodu varsa, hangisini se¢iyor?

Main () metodunun hangi smifta oldugunu derleyiciye biz bildiriyoruz. Ornegin,
ProgramDeneme.cs adli programda Main () metodu Uygulama adli sinifin i¢indeyse ve programi
satir komutuyla derliyorsak,

csc ProgramDeneme.cs /main:Uygulama

komutunu veririz. Eger Visual Studio'yu kullaniyorsak

Solution Explorer -> Properties -> Startup

sekmesinden giris noktas1 (Main() metodunu i¢eren sinif) segilebilir.

4. Bir smifin i¢ine birden ¢ok Main() metodu konulabilir mi?

Hayir. Bir sinifin i¢inde ayni adi tasiyan birden ¢ok 6ge olamaz. [Askin (overloaded) kavramini
ileride ele alacagiz.]

5. Komut satir1 ile derleme ve kosturma eylemlerini ayri1 ayr1 yapabiliyoruz. Visual Studio'da
programi derleme ve kosturma eylemlerini ayr1 ayr1 yapabilir miyiz?

Evet. Programi derlemek i¢in

Build -> Build Solution
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sekmesine tiklariz. Ayni isi F6 tusu ile ya da Ctr1+Shift+B tuslariyla da yapabiliriz. Derlenen
programi kosturmak i¢in Debug -> Start Without Debug sekmesine tiklariz. Program
onceden derlenmemisse, bu komut 6nce derleme eylemini sonra kosturma eylemini yapar. Ayni isi
Ctrl+F5 tuslarina basarak da yapabiliriz.

Visual Studio Express Editions hakkinda nerelerde bilgi bulabilirim?

Microsoft'un http://www.microsoft.com/express/ adresinde en son sistematik bilgileri ve hemen her
konuyla ilgili 6gretici dokiimanlar1 bulabilirsiniz. Ayrica  Visual Studio Express Editions
kullanicisi olarak kaydimizi yaptirabilirsiniz. Boylece bir ¢ok programi iicretsiz edinebilirsiniz. Bu
baglamda

MSDN 2008 Express Edition Library
herkes i¢in mitkemmel bir kaynaktir. Ayrica

http://www.microsoft.com/express/vesharp/

adresinden her zaman bilgi alabilirsiniz.
Visual Studio Express Editions ile ticari programlar yazabilir miyim?

Evet, yazabilirsiniz. Bunu yaptigmiz i¢in kimseye telif veya lisans licreti 6demek zorunda
degilsiniz.

Visual Studio Express Editionsile Visual Studio arasindaki fark nedir?
Visual Studio profesyonel programcilar i¢in daha ¢ok materyale sahiptir. Visual Studio
Express Editions yeni baslayanlar i¢indir. Expressi 6grenenler, isterlerse Visual Studio'ya

yiikselebilirler (upgade). Express ile yazilan programlar, kolayca Visual Studio ortamia
taginabilir. Tabii, Visual Studio'nun ticretli oldugunu séylemeye gerek yok.



